
CD Wizzard Help Index
How to:
Use Main Window
Use Icon Window
Use Registration Dialog
Use Disc Maintenance Dialog
Use Edit Disc Data Dialog
Use Copy Tracks Dialog
Use Program Tracks Dialog
Use Track Playlist Dialog
Use Options Dialog

General Information
Copyright and Licensing
Registration Form
Technical Support
Common Problems
CD-ROM Installation

Reference Information
Menu Commands
Keyboard
Mouse
Term Definitions



How to - how_



CD-ROM Drive Options Dialog
This is a description of the CD-ROM Drive Options Dialog.    This is the dialog that is used to 
configure the CD-ROM Drive for use with CD Wizzard.

To get information on a function or area, click on it in the graphic below.



Copy Tracks Dialog
This is a description of the Copy Tracks Dialog.    This dialog is used to copy disc information 
such as disc name, comments, and track names to the windows clipboard.    The information 
can then be pasted into any windows application such as Notepad or MS Word for Windows.

To get information on a function or area, click on it in the graphic below.



Disc Maintenance Dialog
This is a description of the Disc Maintenance Dialog.    This dialog displays all CDs that have 
been entered into the database for CD Wizzard.

To get information on a function or area, click on it in the graphic below.



Display Options Dialog
This is a description of the Display Options Dialog.    This is the dialog that is used to 
configure the options that effect the look and feel of the main window.

To get information on a function or area, click on it in the graphic below.



Edit Disc Data Dialog
This is a description of the Edit Disc Data Dialog.    This dialog displays all information about 
a particular CD.    This dialog can be used to enter the disc name and track names.

To get information on a function or area, click on it in the graphic below.



Icon Window
This is a description of the CD Wizzard Icon.    The icon is updated with the CD player's 
current status.

The right mouse button may be pressed on the icon to toggle PLAY or PAUSE.

To get information on a function or area, click on it in the graphic below.



Main Window
This is a description of the CD Wizzard Window.    The window is updated with the CD player's
current status.

To get information on a function or area, click on it in the graphic below.



Options
CD Wizzard is very customizable.    The user has many options that can be set to his/her 
preference.    The options are of the following categories:
Display Options - options to configure the main windows look and feel.
Player Options - options to configure the playing of CDs.
CD-ROM Drive Options - options to configure the users CD-ROM Drive.



Player Options Dialog
This is a description of the Player Options Dialog.    This is the dialog that is used to configure
the playing mode for CDs.

To get information on a function or area, click on it in the graphic below.



Print Registration Form Dialog
This is a description of the Print Registration Form Dialog.    This is the dialog that is used to 
get information from the user to be printed on the Registration Form.

To get information on a function or area, click on it in the graphic below.



Program Tracks Dialog
This is a description of the Program Tracks Dialog.    This is the dialog that is used to select 
the tracks and order of play in programmed mode.    The tracks can be dragged and dropped
from the track list to the programmed tracks listboxes.

To get information on a function or area, click on it in the graphic below.



Registration Dialog
This is a description of the Registration Dialog.    This is the dialog that is used to register this
software product.

To get information on a function or area, click on it in the graphic below.



Track Playlist Dialog
This is a description of the Track Playlist Dialog.    This is the dialog that is used to select a 
track to play from the playlist.    The user selects the track and double clicks or presses the 
play button.

To get information on a function or area, click on it in the graphic below.



Windows - wnd_



Always on Top
This command will cause the CD Wizzard icon to have the Always on Top attribute.    This will 
display the icon on top of all other windows, even if it is not the currently selected 
application.



Background
These radio buttons allow the user to select the background for the main window.    The 
different backgrounds are marbled, brushed aluminum, hammered steel, and gray.    When a 
background is selected, a small sample is displayed.



Button Color
These radio buttons allow the user to select the color of the buttons on the main window.    
The different colors are black, green, blue, and red.    When a color is selected a preview of 
the button color is displayed.



CD-ROM Input
These two radio buttons select the device that CD Wizzard uses to control the volume of the 
audio playback.    The two devices follow:
CD Audio Port - this is the internal port on the sound card, usually used for internal CD-ROM 
drives.
Line-In Port - this is the input jack on the back of the sound card, usually used for external 
CD-ROM drives but, sometimes for internal drives with a line-out connector.

Please refer to your CD-ROM drive and Sound card documentation for further details on 
which type of setup you have.

Note: You must have a sound card for CD Wizzard to control the volume of the CD audio.



Comments
The comments field is a free form area that can be used to enter any information about the 
CD.    It will be saved and redisplayed when that CD is edited.    This area may contain a few 
lines of text such as the artist and/or other comments about the disc.



Data
These fields are the users return address data.    The user must enter all information needed 
so that mail can be delivered to the correct address.



Disc Length
This is the total length of the current disc in minutes and seconds.



Disc Name List
This is the list of all disc names that have been entered into the disc database.    The user 
will select a disc name and then press the Edit or Delete button.    Double clicking a disc 
name will edit that discs data.



Disc Name
This is the name of the disc currently being played.    This was entered from the Edit Disc 
Data Dialog.



Embossed Text
Selecting this checkbox will cause all text in the disc name, track name and status bar to be 
embossed or have a sunken 3-D effect.



LED Color
These radio buttons allow the user to select the color of the LED Displays on the main 
window.    The different colors are green, yellow, blue, and red.    When a color is selected, a 
preview of the LED color is displayed.



Minutes
This is the number of minutes that may be used as the length of time to be programmed.    A
number between 1-99 must be entered.    The spin box on the right may also be used to 
increase or decrease the number of minutes.    After the number of minutes is entered, press 
the Set Tracks button to program the desired track length in minutes.



Normal Mode
The normal mode of playback will play all tracks of the CD in the original order.



Playback Mode
This is the current playback mode of CD Wizzard.    It can be Normal, Shuffle or Programmed.



Program Mode
The program mode of playback will play all tracks of the CD selected by the user in the 
Program Tracks dialog.



Programmed Length
This is the total length, in minutes and seconds, of the currently selected tracks that have 
been added to the Programmed Tracks listbox.



Programmed Tracks
This is a listbox that lists all the tracks that have been programmed by the user.    If a track is
selected, the user may press the Clear Track(s) button to remove that track.    A track may be
clicked on and dragged to the trashcan icon to be removed.    A track may also be removed 
by double clicking the track.



Replay Mode
This is the replay mode of CD Wizzard.    The dropdown listbox contains the options No 
Replay - do not replay at all, Replay Current Track - replay the current track continuously, 
and Replay Current Disc - replay the current disc continuously.



Replay Mode Display
This is the current repeat mode.    The three modes are none, track and disc.    Track and disc 
will repeat either the current track or disc.    The user clicks on the Repeat Mode to toggle the
next mode.    It can also be changed from the Player Options Dialog.



Select CD-ROM Drive
This allows users who have more than one CD-ROM drive to select a drive.    All the drives 
attached to the system will be displayed.    The user must select the drive for CD Wizzard in 
order to use this.



Shuffle Mode
The shuffle mode of playback will play all tracks of the CD in a random order.    Each time the
disc is replayed, a different order will be selected.



Start playing on startup
This checkbox indicates whether CD Wizzard will automatically start playing a CD when it is 
inserted into the CD-ROM drive.    If selected, it will cause CD Wizzard to start playing when 
CD Wizzard is first executed.    This allows CD Wizzard to be placed in a users Startup Group 
in Program Manager and have an audio CD begin playing at Windows startup.



Status Bar Display
This is the status bar display.    It will display the current status of the CD player such as 
playing, stopped, etc.    It will also display short help messages when the mouse cursor is 
dragged over certain areas on the window or on menu items.



Stop playing on exit
This checkbox indicates whether CD Wizzard should stop playing on exit from the program.



Text Color
These radio buttons allow the user to select the color of the text in the Disc Name, Track 
Name, and Status Bar areas on the main window.    The color choices are black, blue, and 
red.    When a color is selected, a preview of the text color is displayed.

The embossed text checkbox indicates if the text should be embossed, meaning that it 
would have a 3-D inset.    When the option is changed, a preview of the text is displayed.



Time Display
This is the time mode display of CD Wizzard.    This drop down listbox contains the time 
display modes for the main window.    The display is in minutes and seconds.    The user can 
select between the four modes Time Elapsed in Track, Time Remaining in Track, Time 
Elapsed in Disc and Time Remaining in Disc.



Time Mode Display
This is the current time mode.    The four possible modes are Track Elapsed, Track Remaining,
Disc Elapsed and Disc Remaining.    The user clicks on the Time Mode to toggle the next 
mode.    It can also be changed from the Player Options Dialog.



Track Bar Chart
This is a bar chart showing the amount of the track that has been played.    On the main 
window, but not on the icon window, the user can click the left mouse button on the bar 
chart to start playing at that point of the track.



Track Box Display
This is the display of the tracks on the disc.    Any track may be selected by clicking the left 
mouse button on the track number. The selected track will begin to play.

All of the tracks will start out having the LED Color selected in the Display Options Dialog.    
The track that is currently being played will be purple. Tracks that have already been played 
will be gray.

Note: The Track Box Display is not shown when playing in Programmed Mode.



Track List
This is a listbox with information on the tracks of the current disc.    The listbox contains the 
track number, name and length for each track.    A user may click on a track and drag it to 
the Programmed Tracks listbox to program that track.    A user may also double click a track 
to add it to the bottom of the Programmed Tracks listbox.



Track Name
This is the name of the track currently being played. This was entered from the Edit Disc 
Data Dialog.



Track Number
This is the display of the current track that is being played.



Track Play List
This listbox contains the order of the tracks currently selected from the disc.    This order will 
be sequential for Normal mode, random for Shuffled mode and chosen order for 
Programmed mode.



Track Play List Edit Control
This edit control contains the order of the tracks currently selected for the disc.    This order 
will be sequential for Normal and Shuffled mode and in a chosen order for Programmed 
mode.    It will also contain the Disc name and Comments for the disc.

The user can select any part of the edit control and press the Copy button to copy the text to
the windows clipboard.



Track Scrollbar
This is the scrollbar that controls the scrolling of the Track Name entry fields.



Track Time
This is the display of the current time position of the track that is being played.



Trashcan
This is a trashcan icon.    It can be used to remove tracks from the Programmed Tracks 
listbox.    This is done by dragging the track name and dropping it on the trashcan icon.



Volume Display
This is the volume level display. The user clicks the left mouse button on the volume level to 
change the volume.    The volume can also be controlled by the Up and Down buttons.    The 
volume display device is set in the CD-ROM Options.



User Key
This is the user key.    This a user code that is built from the users name.    All letters in the 
name are used in the key.    Different spelling and capitalization produce different keys.    For 
example, John Doe, john doe and JOHN DOE produce different keys.    The user sends the Key
to BFM Software which is what the password is generated from.



User Name
This is the user name.    The fields are first name, middle name, and last or surname.    The 
name must be at least eight characters long.    The name can not contain blanks.    All letters 
in the name are used for registration, different spelling and capitalization are significant.



User Password
This is the user password.    The password is sent to the user in the registration package 
when a user registers.    This password allows the user to gain full access to the software.



Tolerant Drive Mode
This checkbox is for use with CD-ROM drives that do not support SEEK commands or other 
CD-ROM drive commands.    The user may use this option if CD Wizzard is getting errors 
when tracks are changed or when skipping through the tracks of the disc.    The user can also
try this option when miscellaneous errors are occurring during playback.



Buttons - butt_



Add All Tracks Button
This button will add all tracks to the end of the Programmed Tracks listbox.



Add Track(s) Button
This button will add all selected tracks to the end of the Programmed Tracks listbox.



Calc Key Button
This button will cause the key to be updated with a new key based on the users name.



Cancel Button
This button will cause the current dialog to be closed.    All information entered on the dialog 
will be discarded and not saved.



Clear All Tracks Button
This button will remove all tracks in the Programmed Tracks listbox.



Clear Track(s) Button
This button will remove selected track(s) in the Programmed Tracks listbox.



Close Button
This button will cause the current dialog to be closed.



Copy Button
This button will cause the selected text in the Edit Control to be copied to the windows 
clipboard.



Copy Tracks Button
This button will bring up the Copy Tracks dialog on the selected disc.



Delete Button
This button will cause all information about the selected disc to be deleted.



Down Button

This button will cause the volume of the CD player to be decreased.



Edit Button
This button will bring up the Edit Disc Data dialog on the selected disc.



Edit Disc Data Button
This button will invoke the Edit Disc Data dialog for the disc in the CD player.



Eject Button

This button will cause the CD to be ejected from the CD player.



Forward Button

This button will cause the CD player to skip forward 15 seconds in the current track.    If the 
button is held down, it will continue to skip forward in 15 second intervals.



Help Button
This button will start the windows help system with help on the current dialog.



OK Button
This button will cause the current dialog to be closed and for all information on the dialog to 
be saved.



Pause Button

This button will cause the CD being played to pause.    If paused and the pause button is 
pressed again, this will cause the CD Player to play.    The CD player can also be restarted by 

pressing the play  button.



Play Button

This button will cause the CD to begin playing.    If the CD player is paused, it will start to 
play at the point from which it was paused.



Print Button
This button will print the Registration Form.    The form will be printed to windows default 
printer.



Print Form Button
This button will open the Print Registration Form Dialog.    This dialog will allow the user to 
enter the return address.    Then the registration form can be printed.



Program Tracks Button
This button is used to bring up the Program Tracks dialog.    This button is only active when 
the program playing mode is selected.



Register Button
This button will cause the users name, key and password to be validated and saved in the 
system.    The program will now be registered and all software security will be deactivated.    
The program will now be fully functional.



Reverse Button

This button will cause the CD player to skip back 15 seconds in the current track.    If the 
button is held down, it will continue to skip back in 15 second intervals.



Save Button
This button will cause all information on the dialog to be saved.



Set Tracks Button
This button will clear all currently selected tracks in the Programmed Tracks listbox and then 
create a list of tracks in the Programmed Tracks listbox that equals or comes as close as 
possible to the number of minutes entered.



Stop Button

This button will cause the CD being played to stop.    The CD player will reset to the first 
track in the sequence.    The CD player can be restarted by pressing the play  button.



Track Forward Button

This button will make the next track the current track.    If the CD player is currently being 
played, the track will begin to play.    If shuffle is selected, the next shuffled track will be 
selected to play.



Track Info Button
This will invoke the Track Information Dialog for the tracks currently being played in the CD 
player.



Track Reverse Button

This button will make the previous track the current track.    If the CD player is currently 
being played, the track will begin to play.    If shuffle is selected, the previous shuffled track 
will be selected to play.



Up Button

This button will cause the volume of the CD player to be increased.
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CD-ROM Installation
CD-ROM Audio in Windows 3.1

This is a complete description of the support for CD-ROM Audio in Windows 3.1.    This article 
will try to completely explain the CD-ROM environment.    It will also include a detailed list of 
things that need to be done to use Music CDs in your CD-ROM under Windows 3.1.

The support for CD-ROM Audio is a multilevel cooperation of three levels of drivers.    They 
are the manufacture's CD-ROM device driver, Microsoft's MSCDEX.EXE, and Windows 3.1 
MCICDA.DRV.    These are the three drivers required to use the CD-ROM Audio support in 
Windows 3.1.    The manufacture's driver interfaces directly to the CD-ROM device.    It talks 
to MSCDEX.EXE.    MSCDEX.EXE is the programmers Red Book CD Audio driver.    It talks to 
MCICDA.DRV of Windows 3.1.    MCICDA.DRV supports Windows applications using CD Audio.   
It talks to Windows programs.    CD Wizzard(TM), a windows application, talks to MCICDA.DRV.

All three drivers must be installed and configured correctly to play music CDs.    When 
Windows 3.1 setup program is run, it checks for the presence of MSCDEX.EXE.    If it is found, 
it will create an entry for MCICDA.DRV in your system.    But, it will NOT install the driver!    
This must be done by the user after the installation is completed.    CD Wizzard gives 
instructions on how to do this when it detects the situation.    Following are the exact steps to
add all these drivers to your system:

A) Add your manufacture's driver supplied with the CD-ROM Drive to CONFIG.SYS.
B) Add MSCDEX.EXE from manufacture or Microsoft to AUTOEXEC.BAT.
C) Configure the above drivers for each other. Use the documentation from 

manufacture.
D) Go to Control Panel in windows and select Drivers Icon.
E) Press the ADD Button.
F) Select "[MCI] CD Audio" entry and press OK Button
G) Insert Windows Disk asked for and follow instructions.
H) Restart windows.    You should now be able to Run CD Wizzard to play Music CDs.    

If after the above steps you are still not getting the MCICDA.DRV to run, follow these 
instructions:

A) Edit SYSTEM.INI.
B) Find the [MCI] section.
C) There should be a "CDAudio=mcicda.drv" entry.    If not, add it.
D) Save SYSTEM.INI and exit editor.
E) Do a directory listing on your <windows>\SYSTEM directory.
F) Is MCICDA.DRV present?    If not:

1) Search Windows 3.1 Install disks for a file    
"MCICDA.DR_".    On 3 1/2 HD it is #4.

2) Use EXPAND.EXE command to expand file to <windows>\SYSTEM.
3) Restart windows.

One major problem that we have seen with CD-ROM drives is that the lens pickup system 
gets dirty easily.    This can cause the CD-ROM drive to act very strange.    It will skip in 
playing songs, reset the drive, or not play a disk at all.    To clean a CD-ROM drive, a CD 
cleaning disc can be bought at most audio stores.    Run the disc through the drive.    This 
should solve the problem.    You should clean your drive at least every 60 days.



Common Problems
This section contains a list of common problems using CD Wizzard.    The following are the 
known problems:
Error Number: 262.    This error is a general CD-ROM Driver error code.    It is usually do to the
CD-ROM drive not supporting SEEK commands.    Try setting the Tolerant Drive Mode option 
in Player Options.    This should remove the error.
CD-ROM players have problems playing some music CD discs.    The player will appear to 
loop or just reset occasionally.    This could be do to a dirty lens pickup system.    Buy a CD 
cleaning disc from an audio store.    Run the disc through the CD-ROM.    If the problem is still 
present, contact the maker of the CD-ROM for service.
Forward and reverse commands take a long time to reposition.    This appears to be a bug in 
some CD-ROM device drivers.    Try setting the Tolerant Drive Mode option in Player Options.   
This should remove the error.
Data CD-ROM discs do not have the same format as Music CDs.    They will cause a Data Disc
message to be displayed.
While CD Wizzard is playing, during the access to your CD-ROM, your system may slow down
slightly.    This is do to the multimedia extensions of windows.    The slowdown should only be 
minor.



Copyright and Licensing

Copyright © BFM Software 1994
Copyright © Brett McDonald 1994

Following are the system requirements:
1) 286 or higher processor
2) Windows 3.1 or higher
3) Mouse or other pointing device
4) Color monitor - High SVGA resolution recommended.

ATTENTION Registered WinCD users: Your password will work with CD Wizzard, just enter 
your name exactly as you did in WinCD along with your old password into CD Wizzard.    
WinCD is no longer supported by BFM Software, CD Wizzard is a complete replacement for 
WinCD.    Please contact us for further details.

This software is shareware.    This software is NOT free.    If you like the software and continue
to use it, you MUST register the software.    Registration Fee: $15.95 US.

BFM Software
Brett McDonald
38602 Lancaster Drive
Farmington Hills, MI    48331
Phone: (810) 661-1797

To receive a disk with our latest software add $4.00 to the registration fee.

Following are our BBS IDs:
Compuserve ID - 73770,1254
American On-line ID - BrettMc

We are a member of the Compuserve Shareware Registration system.    You may register 
BFM Software products with Compuserve.    They will add the fee to your bill and we will send
you the registration.    To access this system enter "GO SWREG".    Select Register Shareware. 
Then search for the keyword "BFM" to find all BFM Software products.

Please include your name EXACTLY as you want it registered and the generated key from the
registration dialog box.

You may distribute this software as long as the following files are included:
CDWREAD.TXT
CDAUDIO.TXT
CDW.EXE
CDW.HLP

All of the above files, must be combined into a single file ZIP or other compression format for
distribution.

Beyond a fee for the reproduction and media cost, no fee may be charged for distribution of 
this software.

This software claims no warranty, implied or otherwise.    This software is provided "AS IS".    
The author claims no responsibility for any damages that might be caused by the use or 
abuse of this software.    This software remains the property of the author.    This software 



may not be modified in any way.



Registration
Note: To print this registration form select FILE then PRINT TOPIC from menu.

CD Wizzard Registration Form

Version: ______

Name to be registered: _________________________________

Generated key: __________

Ship to address: ____________________________________

____________________________________

____________________________________

____________________________________

Please send check or money order for $15.95 US    To:
BFM Software
Brett McDonald
38602 Lancaster Drive
Farmington Hills, MI    48331

To receive a disk with our latest software add $4.00 US



Technical Support
BFM Software will try to help any user to the fullest of our abilities.    We do prefer to help 
registered users with problems concerning our software, but we will try to help anyone we 
can.    Below are the ways a user can contact us:
Electronic Service Compuserve - our ID is 73770,1254
Electronic Service American On-line - our ID is BrettMc
Our mailing address:

BFM Software
Brett McDonald
38602 Lancaster Drive
Farmington Hills, MI 48331

Phone Number: (810)661-1797
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Menu Commands
These are the menus on the main windows menu bar.
File Menu
Discs Menu
Options Menu
Help Menu

The CD-ROM Controls Menu is added to the system menu for the main and icon window.    
The user simply clicks on the system box at the top of the main window or clicks on the icon 
when iconized.



File Menu
The File Menu includes commands that enable the user to get control of the entire program.  
They are as follows:
Register Command
CD-ROM Controls Menu
Uninstall Command
Exit Command



Register Command
Selecting the Register Command will cause Registration dialog to be displayed. The register 
command is used to register the program.

The register dialog box has directions on the steps needed to register the program.    This 
program must be registered after the 15 day trial period.



CD-ROM Controls Menu
These are the menu commands that control the CD-ROM drive.    They are listed below:
Play - Start playing a CD.
Pause - Pause or resume playing.
Stop - Stop Playing.
Eject - Eject the current CD.
Track Reverse - Go to the previous track in the playlist.
Track Forward - Go to the next track in the playlist.
Volume Up - Increase the volume of the CD-ROM device.
Volume Down - Decrease the volume of the CD-ROM device.



Uninstall Command
Selecting the Uninstall Command from the File Menu will cause a message box to be 
displayed.    The user can select YES or NO to uninstall CD Wizzard.

The following files are removed from the user's system in the uninstall processing:
CDWREAD.TXT - text file with miscellaneous CD Wizzard information
CDW.HLP - CD Wizzard help file
CDW.INI - CD Wizzard parameter file
DATAxx.INI - CD Wizzard database files
CDW.EXE - CD Wizzard program file
CDAUDIO.TXT - Audio installation help file

Note: If SHARE.EXE is installed in the user's system, CD Wizzard will come across an error in
the uninstall process.    SHARE.EXE will not allow a program to access a file that another 
program is accessing.    Windows is executing CDW.EXE so the program cannot access it to 
delete it.    The error message can be ignored and the CDW.EXE file deleted by hand.



Exit Command
Selecting the Exit Command from the File Menu will terminate CD Wizzard.



Discs Menu
The Discs Menu includes commands that enable the user to work with CD Discs.    They are 
as follows:
Display Track Playlist Command
Edit Current Disc Data Command
Copy Track Playlist Command
Maintain Discs Command



Display Track Playlist Command
This command displays the Track Playlist Dialog with information about the current track 
playlist. This dialog allows the user to select a different track to be played.



Edit Current Disc Data Command
This command displays the Edit Disc Data Dialog with information about the inserted CD 
Disc.    This dialog allows the user to change all the information about the disc in the 
database.



Copy Track Playlist Command
This command displays the Copy Tracks Data Dialog to allow the user to copy disc 
information to the windows clipboard.



Maintain Discs Command
This command displays the Maintain Discs dialog box with all the discs CD Wizzard has 
saved in its database.    This command can be used to delete unwanted discs from the 
database.



Options Menu
The Options Menu includes commands that enable the user to control options of the 
program.    The options are of the following categories:
Screen Options - options to configure the main windows look and feel.
Playback Options - options to configure the playing of CDs.
CD-ROM Drive Options - options to configure the users CD-ROM Drive.



Help Menu
The Help Menu includes options that enable the user to get help for the program.

For more information, the user should select the Help Menu Command Name:
Help Index Command
Using Help Command
About Command



Help Index Command
The Help Index command is used to invoke the Windows Help engine.    It will start up with 
the help index for CD Wizzard.



Using Help Command
The Using Help command will display help on the Using Windows help system.



About Command
The About command will display a short dialog box that displays copyright and registration 
information.    The More button may be pressed to display a picture of the development team
for this software.    The Register button may be pressed to register the software.
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Keyboard
Keyboard commands are shortcuts to the button options.

The following are the keyboard shortcut commands:
Button Short-cut Key

Play 'Ctrl-P'
Pause 'Ctrl-A'
Stop 'Ctrl-S'
Eject 'Ctrl-E'
Track Reverse 'Ctrl-R'
Track Forward 'Ctrl-F'
Volume Up 'Ctrl-U'
Volume Down 'Ctrl-D'
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Mouse
The mouse has a few special functions in CD Wizzard.    In the main window it is used to 
press the buttons.    In certain areas the mouse may be clicked to have special meaning.    
When the  cursor is displayed, these special actions are active.    The Status Bar will have
a short message about what happens in that area.

When the CD Wizzard icon is displayed, the right mouse button may be pressed on the icon 
to toggle play or pause mode.
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CD Wizzard Definitions
The following are the defined terms of the program:
CD-ROM
CD Wizzard
Clipboard
Disc
Playlist
Track



CD-ROM
A CD-ROM stands for Compact Disc Read Only Memory disc.    A CD-ROM drive uses a laser 
beam to read very tiny ones and zeros from the encoded foil layer of the disc.    A CD-ROM 
drive can handle over 650 megabytes of data.



CD Wizzard
CD Wizzard is a copyrighted work created by BFM Software.

Copyright © BFM Software 1994
Copyright © Brett McDonald 1994
All rights reserved by author.



Clipboard
This is the Windows Clipboard.    The clipboard is used to place temporary information that is 
being copied.    A user places information on the clipboard by copying and then pastes the 
information into another program.



Disc
A disc stands for a CD-ROM disc.    Discs come in a few difference types Audio - contain audio
tracks, Data - contain a data track, and Mixed - which contain both a data track and audio 
tracks.    The CD player you might have in your home can only read Audio CDs.    The CD-ROM
in your computer can read all three.



Playlist
This is the list of tracks that is currently selected to be played.    In normal mode all tracks 
are played sequentially, in shuffle the tracks are in random order, and in programmed mode 
the tracks are in the order the user selected.



Track
A track is a part of a disc that can contain one song for an audio disc or many files of 
information on a data disc.    A track on CD-ROM is different than a computer disk because 
the tracks spiral together.    Rather, a computer disk has many circular tracks that do not 
intersect.    This is why CD-ROM drives have a much slower access time than computer disk 
drives.




